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Lesson summary 
Deep clear lakes are characterized by large volume of good quality waters thus providing a 
wide range of ecosystem services (e.g. biodiversity, climate change mitigation, fishery, 
drinking water, tourism and recreation). Although these lakes are less vulnerable to 
eutrophication than small shallow lakes, a continuous input of nutrients has led to increasing 
eutrophication in many of them. Conversely, improved practices in water management (e.g. 
fertilization policy) might lead to trophic status decreasing in other lakes. This lesson covers 
how we can use satellite data to assess the trend of trophic level in Lake Tanganyika, the 
third largest lake in the world by volume, one of the richest freshwater ecosystems supplying 
fish in the diet of the one million people living around the lake. 

 
 

GLaSS training material outline 
This lesson is part of the GLaSS training material. The complete training material outline is 
listed on http://data.waterinsight.nl/GLaSS/trainingmaterials/GLaSS_lesson_outline.pdf. 

Note that the lessons logically follow up on each other, the later lessons might require skills 
that can be acquired during the earlier lessons. 

http://data.waterinsight.nl/GLaSS/trainingmaterials/GLaSS_lesson_outline.pdf
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List of abbreviations 
Abbreviation  Description 
CC CoastColour 
CDOM Colored dissolved organic matter 

Chl Chlorophyll 
EO Earth observation 
MERIS Medium Resolution Imaging Spectrometer 

MODIS Moderate Resolution Imaging Spectroradiometer 
ROI Region Of Interest 
WISP-3 Water Insight SPectrometer with 3 radiometers 
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1 Introduction 
Deep clear lakes are essential strategic resources, constitute an environment for ecosystem 
(flora and fauna) and supply waters for industry, domestic and agriculture uses. Overall, they 
provide multiple ecosystem services and are resources for recreation and tourism, with their 
attractions of landscape, mild climate and water quality. To preserve these vital ecosystems it 
is important to understand their complete evolution by continuous long-term monitoring of 
trophic status and water quality.  

Over the past decade, latest generation of ocean colour sensors such as MODIS and 
MERIS, with their specific capacities for resolving productive and turbid waters, have 
provided unique information for lake monitoring. In particular, those sensors allow the 
concentration of chlorophyll-a as a proxy of phytoplankton biomass and hence of trophic 
level to be accurately assessed from season to season during time at global scale. 

This lesson relies on the 12-years long MERIS time series and aims to describe the trophic 
status trend in Lake Tanganyika a deep clear lake in the African Rift. With an average depth 
of 570 m and a surface of 18,900 km3, Lake Tanganyika is the third largest lake in the world 
by volume and one of the richest freshwater ecosystems: about 600 of these species exist 
nowhere else in the world outside the Lake Tanganyika watershed. The lake is an important 
source of fish for consumption and for trade as approximately one million people lives there. 
The lake is also a vital transport and communications link between the bordering countries 
Tanzania, Congo, Burundi and Zambia.  

The trophic status trend in Lake Tanganyika is obtained by applying statistical tests to 
chlorophyll (Chl) concentration obtained from MERIS imagery. To capture the patchy 
distribution of phytoplankton, the analysis is performed for at sub-basin scales. A variety of 
tools available in BEAM-VISAT will be used for such purposes. 
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2 This lesson 

2.1 Research question 
Is Lake Tanganyika subject to eutrophication? 

2.2 Training objectives / skills to gain in this lesson 
The aim of this lesson is to analyze trends in the trophic level evolution in Lake Tanganyika. 
Teaching students on how to assess the trophic status tendency in a big deep clear lake 
based on processing of long term time series of MERIS data. 

• Visualization of MERIS-derived products 

• Spatial analysis  

• Definition of region of interests (ROI) on image data 

• Application of BEAM tools on time series of Chl products for long-time series analysis 

• Use of Kendall test to statistically assess if there is a monotonic upward or downward 
trend in Chl data 

2.3 Required software and data 

Software and tools 
To complete this lesson tasks, the following tools and software are required or suggested: 

• BEAM/SNAP 2.0 (required, see Lesson #1). 
Figures and buttons position in this document are referred to the BEAM-VISAT 
interface. Some slight difference may occur in SNAP interface. 

• R (see https://www.r-project.org/ for free downloading and details) incl. xts, rkt, date 
and chron packages (Ryan and Ulrich, 2014; Marchetto, 2015; Therneau et al., 2014; 
James and Hornik, 2015) are suggested to perform the trend analysis (in Part 4) 
through the scripts provided but any software in which you could perform trend 
analysis could be used. Packages can be installed following instructions in provided 
scripts. 

Downloadable files 
• GLaSS_Training_Lesson4.pdf 

The main document of the lesson including exercises and questions. 

• GLaSS_Training_Lesson4_Answers.pdf 
A document containing answers to all questions proposed in the exercises. 

• GLaSS_Training_Lesson4_DataAndTools.zip 
Supplied data and tools, described below. 

The zip-file with supplied data and tools contain:  

A ‘Sample_data’ directory containing: 

• 9 WISP-3 products derived from MERIS CoastColor (CC) images of Lake Tanganyika 
in NetCDF format (e.g. 
MER_FSG_CCL2R_20030823_080617_000002192019_00164_07733_5705.nc). 

https://www.r-project.org/
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• ‘Tanganyika_regions.shp’: shapefile of the sub-basins selected for the trophic status 
trend evaluation. 

• ‘Tanganyika_Monthly.txt’: Chl statistics extracted from all available images from two of 
the regions contained in Tangayika_regions.shp, aggregated on monthly basis.  

• ‘Tanganyika_regions_coord.txt’: ascii file containing centre coordinates of the same 
regions included in the shapefile. 

A ‘Tools’ directory containing: 

• ‘Longtime_trend.R’, R script for the analysis of long-time trend Chl concentration. 

• ‘Stats_extraction_StatisticsOp.xml’ and ‘Stats_extraction_PixEx.xml’ for the extraction 
through BEAM operators (respectively StatisticsOp and PixEx) in batch mode Chl 
values from MERIS Tanganyika products. 
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3 Exercise 

Part 1 Single image visualization and analysis of level-2 products 
In the GLaSS project core, for the estimation of Chl concentration, the WISP-3 algorithm was 
applied to flagged Level 2 MERIS-CC remote sensing reflectances. The WISP-3 algorithm 
(Peters et al., 2013) is a semi-analytical approach that uses an iterative scheme to calculate 
water quality parameters. In this first part, BEAM-VISAT tools are used for data visualization 
and for statistics extraction and spatial distribution analysis. 

Activities 
 Start VISAT, the BEAM interface (find it in ...\beam-5.0\bin). 

 Open the MERIS image of May 23rd 2009 (File > Open Product and select image 
’MER_FSG_CCL2R_20090523_080717_000003402079_00164_37793_6600.nc’). 
You can read the date from the image name. 

 In the Products tab, expand product main folder, expand ‘Bands’ folder: several 
products are displayed, including TSM, CDOM and Chl concentration. Double click on 
wisptest_chl to open a grey-scale map of Chl concentration. 

 Expand ‘Metadata’>’Variable_Attributes’ folder to find out more information on each 
variable: in particular, double clicking on wisptest_chl info are shown as in Figure 1. 

 
Figure 1. Metadata of Chl WISP-3 product. 

 

o What are the variable units?  

 Close metadata window and return back to Chl map: Chl values can be shown 
clicking on Pixel info tab and moving the pointer across the map (it shows the value 
for each pixel pointed)  

 Switch to Colour manipulation tab: choose Editor Basic and the colour ramp you 
prefer (for example ’meris_algal’. Change Minimum and Maximum values to be 
included in the scale range. Choosing the Editor Sliders, you can change the sliders 
distribution manually or distributing in equal intervals clicking on  button. 

As shown in Figure 2, Chl concentration is not the same in the whole lake, but it varies in 
space.  

o Where Chl concentration is higher? 
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Figure 2. Tanganyika Chl map on May 23rd 2009, as shown in BEAM-VISAT, and 
Colour Manipulation Tab (bottom-left). 

 

 Select wisptest_chl by left-clicking on the band name in the Product Explorer panel 
and select Statistics to show statistical values of the whole image: click on  to 
generate statistics. The tool will show statistics for the whole image, including pixels 
that don’t belong to Lake Tanganyika. In the next section it will be discussed how to 
compute statistics for lake pixels only. 

 
Figure 3. Statistics compute for the whole image of May 23rd 2009. 
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Part 2 Masks generation for products analysis  
ROIs and masks can be useful in EO products analysis both to exclude pixels you are not 
interested in or conversely to consider only some pixels, mainly when values and statistics 
are extracted from them. As discussed in lesson 2, masks can be defined by several tools, by 
manually drawing them, through logical band math expressions or importing existing 
shapefile or csv file containing single points coordinates.  

Activities 
To create a mask containing Tanganyika pixels only, ‘Tanganyika_regions.shp’ shapefile can 
be imported:  

 File > Import Vector Data > ESRI Shapefile and select ‘Tanganyika_regions.shp’. The 
files contains 5 polygons dividing the lake in 5 different sub-basins. BEAM asks you 
whether you want to use them separately. At this step we want to consider the whole 
lake, thus choose No. The shapefile is thus imported both as vector and mask and 

can be managed through both Vector Manager  and Mask Manager , to choose 
visibility, colour visualization and transparency. 

Statistics can be now extracted for Tanganyika pixels only: 

 Open again . This time tag use ROI mask(s) and select the ‘Tanganyika_regions’ 
mask. Then click on  to obtain statistics.  

o What’s Chl mean and median concentration? What’s the maximum value in the lake? 

 Import again the ‘Tanganyika_regions.shp’ shapefile but this time choose Yes when 
BEAM asks you whether you want to use them separately, indicating ‘Basin’ as 
‘Attribute for mask/layer naming’. 5 different geometries and masks are generated.  

o What’s Chl mean value in ‘Centre’ region? And in ‘South’ region? 

 

Let’s generate a mask containing only pixels in Lake Tanganyika with high Chl concentration, 
using as a threshold the sum of mean and standard deviation. 

 Open  and then  to define a new mask on a new logical band math 
expression. In the Expression window type ‘Tanganyika_regions & wisptest_chl > 
2.58’, to include only Lake Tanganyika pixels and with Chl concentration higher than 
2.58 (the sum of Chl mean and standard deviation). 

 A new mask is generated: open  and calculate again statistics using it. 

o In how many pixels Chl exceeds the threshold defined above? 
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Part 3 Long-time series generation from EO products data through BEAM PixEx 
or StatisticsOp operators 

Both PixEx and StatisticsOp operators are useful for statistics extraction from remote sensing 
products.  

PixEx extracts alternatively, the value contained in a pixel or in a group of pixels, giving all 
values (with ‘no aggregation’ method), the mean, the minimum, the maximum or the median 
value of pixels in a square window of a given size centred in a point of given coordinates. It 
extracts statistics from all available products given in input.  

StatisticsOp extracts statistics (including given percentiles) from pixels defined by input 
shapefile. It aggregates the values on temporal basis, using the time interval defined. 

These tools are useful for the generation of long-time series of data for further analysis. 

Activities 
 In the folder ‘Tools’ open the ‘Stats_extraction_PixEx.xml’ file: 

• Complete the path for the directory in which MERIS images are stored and the 
file pattern (the pattern of all the products you want to include in your 
analysis), in this case 
‘<sourceProductPaths>...\Sample_data\*.nc</sourceProductPaths>‘. PixEx 
will recursively look for all NetCDF products in the folder. 

• Complete the path of the file containing Lake Tanganyika regions centre 
coordinates 
(‘<coordinatesFile>...\Sample_data\Tanganyika_regions_coord.txt</coordinate
sFile>’) and the size of the window for statistics extraction: with 
‘<windowSize>3</windowSize>’ a three by three pixels window is defined. 

• Define the output path (a directory where you want to store PixEx results) and 
the prefix you prefer for the name of results file. 

• An expression can be used to define valid pixels: 
‘<expression>!l2_flags.L2R_INVALID and !l2_flags.L2R_SUSPECT and 
!l2_flags.INPUT_INVALID and (wisptest_chl &lt; 50) and (wisptest_chl &gt; 
0)</expression’. It means that the tool will skip pixels defined as suspected or 
invalid by Level 1 and 2 processors and with Chl concentration higher than 50 
µg/l, to avoid pixels with too high values, affected by any kind of problem like 
mixed pixels near the coast. 

• Define the aggregation method choosing among ‘no aggregation’, ‘min’, ‘max’, 
‘mean’, ‘median’. 

 Open BEAM Command Line (look for it in your browser typing ‘cmd’) and type  
‘gpt …\Tools\ Stats_extraction_PixEx.xml’ (complete the directory path, do not use 
blank spaces). PixEx starts collecting all available products in the selected folder. 

 Two files are thus generated in the output directory, ‘Tanganyika_ measurements.txt’ 
and ‘Tanganyika_productIdMap.txt’, containing, respectively, the values extracted 
from valid pixels for each station defined in the coordinates file, for all available bands 
in the input products and a list of all products used for statistics extraction. 

 Import ‘Tanganyika_ measurements.txt’ in a spreadsheet. 

o Where and when the highest Chl concentration was recorded? 
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If you want to use a shapefile (or a geometry you have previously created in BEAM and 
suitably saved as a shapefile) you should use StatisticsOp recursively for each image, which 
would take much more time for the generation of long time series. On the other hand, 
accounting for the annual or seasonal mean of any parameter, it allows the generation of 
overall statistics, both in ascii and in shapefile format. 

 In the folder ‘Tools’, open the ‘Stats_extraction_StatisticsOp.xml’ file: 

• Complete the path for the source product as previously done with PixEx 
operator. 

• Complete the path for the Shapefile containing Lake Tanganyika regions 
polygons to be used to extract values and calculate statistics: 
‘<shapefile>...\Sample_data\Tanganyika_regions.shp</shapefile>’. 

• Define the time interval for statistics extraction and aggregation: StatisticsOp 
considers only product which date is included in this interval: 
‘<startDate/>2002-05-01 00:00:00’ and ‘<endDate/>2002-12-31 23:59:00’. 

• Define the band name containing values to be extracted: 
‘<sourceBandName>wisptest_chl</sourceBandName>’. 

• The same expression used for PixEx could be used to define valid pixels. 

• Complete output files path for ascii and Shapefile output files. 

• Finally choose the percentiles to be calculated among statistics: e.g. 
‘<percentiles>25,75</percentiles>’. 

 Open BEAM Command Line (look for it in your browser typing ‘cmd’) and type  
‘gpt …\Tools\ Stats_extraction_StatisticsOp.xml’ (complete the directory path, do not 
use blank spaces). StatisticsOp starts collecting all available products in the selected 
time interval, in the selected folder. 

 Open the output ascii file thus generated, named ‘Tanganyika_results.txt’: it contains 
for each region average (‘vrg_0’), maximum (‘mx_0’), median (‘mdn_0’) and minimum 
(‘mn_0’) values, selected percentiles and, in column ‘total’, the number of valid pixels 
used for the calculation.  

The output shapefile contains the same information.  

o On the basis of the images provided, what’s the overall mean value for Lake 
Tanganyika regions? 
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Part 4 Long-time trend analysis of Chl concentration through Seasonal Kendall 
test 

The Mann-Kendall test, is a non-parametric test, which allows the evaluation of monotonic 
trend over time. The Seasonal Kendall test (Hirsch and Slack, 1984) is a modification of the 
Mann-Kendall’s, which allows taking into account seasonal patterns in the evaluation of 
monotonic trend. In the Mann-Kendall test, the statistic S, which is the difference between the 
number of pairwise slopes that are positive minus the number that are negative, is calculated 
by listing values in temporal order. The null hypothesis condition for this test is that there isn’t 
any temporal trend in the data values, with a confidence limit of 0.05. In seasonal 
modification, the same statistic is calculated on each season separately and then the results 
are combined by summing up statistic Si for each season i over all seasons to form the 
overall test statistic Sk. Along with this test, the Sen Slope can be calculated as indicator of 
median annual slope, calculating the slope of all possible pairs of values in each season. In 
this exercise we will consider 12 seasons (12 months) and we will use Chl values extracted 
from ‘Centre’ and ‘North’ regions from all available images from 2003 to 2011, aggregated on 
monthly basis. 

Activities 
 Start the R console you installed and open ‘Longtime_trend.R’. 

 Complete the script defining the path and file name containing Tanganyika monthly 
average values (‘data <- read.table 
(‘.../Sample_data/results_for_Tanganyika_month.txt’, header=TRUE, sep=‘\t’). 

 Start the script. 

The script provides the result of Seasonal Kendall test made on both regions in addition to 
the time series plots. 

o What’s Chl long-time trend from 2003 to 2011 for regions ‘Centre’ and ‘North’? Is it 
meaningful? 
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4 More information and further reading 
This lesson is based on the following report:  

• GLaSS Deliverable 5.3, 2015. Global Lakes Sentinel Services, D5.3: Deep clear 
lakes with increasing eutrophication. CNR, WI, EOMAP, BG. Available via: 
http://www.glass-project.eu/downloads/ 

 

The report is suggested for further reading. It contains: 

• Lake Garda 

• Lake Maggiore 

• Lake Constance 

• Lake Vättern 

• Lake Michigan 

• Lake Malawi 

For more information on GLaSS, and to download all public reports: www.glass-project.eu.  

  

http://www.glass-project.eu/downloads/
http://www.glass-project.eu/
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